The information in this document is subject to change without notice. The software described in this document is provided under license agreement and may be used or copied only in accordance with the terms of the license agreement.

The information, drawings, and illustrations contained herein are the property of Control Technology Corporation. No part of this manual may be reproduced or distributed by any means, electronic or mechanical, for any purpose other than the purchaser’s personal use, without the express written consent of the Control Technology Corporation:

The following are trademarks of Control Technology Corporation:

- Quickstep
- CTC Monitor
- CTC Utilities

The American Advantage is a registered trademark of Control Technology Corporation. MS-DOS and Windows are trademarks of Microsoft Corporation. DeviceNet is a trademark of Allen-Bradley Company.
Contents

Notes To Readers .................................................................................................................. vii

1 Getting Started
   Setting Up Computer–Controller Connections ................................................................. 2
   Using the RS-232 Port for CTC Monitor – Controller Communications ....................... 2
   Using Ethernet for CTC Monitor – Controller Communications ................................. 3
   Launching CTC Monitor ................................................................................................. 4
   CTC Monitor Overview ................................................................................................. 6
   CTC Monitor Window Overview .................................................................................... 7
   Configuring Computer–Controller Communications ..................................................... 8
      Configuring RS-232 Communications ....................................................................... 8
      Configuring Ethernet Communications .................................................................. 9
   Displaying Controller Configuration Information ....................................................... 10
   Starting, Stopping, and Resetting the Controller ......................................................... 12

2 Monitoring Controller Resources and I/O Devices
   Monitoring Registers .................................................................................................. 14
      Viewing Register Values ......................................................................................... 15
      Changing or Entering the Value in a Register ......................................................... 15
   Monitoring Flags ....................................................................................................... 16
      Viewing Flag States ............................................................................................... 17
      Changing the State of a Flag ................................................................................. 17
   Monitoring Digital Inputs .......................................................................................... 18
      Viewing Input States ............................................................................................. 19
   Monitoring Analog Inputs .......................................................................................... 20
      Viewing Analog Input Values ................................................................................. 20
   Monitoring Digital Outputs ....................................................................................... 22
      Viewing Output States .......................................................................................... 23
      Turning Digital Outputs On and Off .................................................................... 23
   Monitoring Analog Outputs ....................................................................................... 24
      Viewing Current Analog Output Values ............................................................... 25
      Changing Analog Output Values ......................................................................... 25
   Monitoring Servo Motors ......................................................................................... 26
      Viewing Servo Position and Error Values ............................................................. 26
   Monitoring NVRam Module Registers ....................................................................... 27
      Viewing an NVRAM Module Register Values ..................................................... 28
      Changing or Entering the Value in an NVRAM Module Register ......................... 28
   Monitoring Program Step Status ............................................................................ 29
      Monitoring Program Tasks .................................................................................... 29
      Reading System Fault Messages .......................................................................... 29
## Contents

### 3 Working with Symbol Tables and Register Files
- File Menu Overview .................................................................................... 32
- Opening a Symbol Table ........................................................................... 33
- Opening a Register File ............................................................................ 34
- Uploading Register Data and Creating a File ........................................... 35
- Downloading a Register File ..................................................................... 36

### 4 Working with the Data Table Dialog Box
- Data Table Dialog Box Overview ............................................................. 38
  - The Toolbar ........................................................................................... 39
  - Saving an Existing Data Table ................................................................ 40
  - Changing the Font ................................................................................. 40
  - Opening a Data Table File .................................................................... 41
  - Uploading and Downloading a Data Table ........................................... 41
- Entering Numbers and Messages ............................................................... 42
  - Entering and Editing Numbers in the Data Table ................................... 42
  - Entering Messages ................................................................................ 42
- Realtime Data Table Monitoring ............................................................... 43
  - Setting the Data Table Monitor Parameters ....................................... 43
  - Starting and Ending Data Table Monitoring .......................................... 44

### 5 Creating Custom Dialog Boxes
- Custom Display Dialog Box Overview ...................................................... 46
  - Resource Display Dialog Box ............................................................... 46
  - Label Display Dialog Box ..................................................................... 47
  - Changing Values in a Custom Dialog box ............................................. 48
  - Saving a New Custom Dialog Box ......................................................... 48
  - Saving an Existing Custom Dialog Box ................................................. 48
  - Opening a Custom Dialog Box .............................................................. 49
- Creating a Custom Dialog Box .................................................................. 50

### 6 Using CTC Monitor as a DDE Server
- Overview of the DDE Setup Dialog Boxes .............................................. 52
  - Flag Register Configuration Dialog Box ............................................... 52
  - Block Write Configuration Dialog Box .................................................. 54
- Opening a DDE Communications Channel .............................................. 56
- Reading Register Values Using a DDE Application ............................... 57
  - Reading Register Values ..................................................................... 57
- Setting up the Flag Register Configuration Dialog Box .......................... 58
  - Setting up the DDE Application to Read the Flag Register Configuration Dialog Box 59
  - Setting Up the Block Write Configuration Dialog Box .......................... 60
  - Setting up the DDE Application to Read the Block Write Configuration Dialog Box 61
- Reading a Flag’s State from a DDE Application ...................................... 62
- Writing Register Values Using a DDE Application .................................. 63
  - Writing to the Flag Register Configuration Dialog Box from a DDE Application 63
  - Changing a Flag’s State from a DDE Application .................................. 65
Appendix A  Installation Instructions
Installing CTC Monitor ................................................................. 68
   For Windows 95, Windows 98 and Windows NT Users .................. 68
   For Windows 3.11 Users ............................................................ 68

Appendix B  Sample Visual Basic Programs
   Opening a DDE Channel ............................................................ 70
   Reset Value in Register ........................................................... 71
   Downloading Changes to the Controller ..................................... 72
   Resetting the Values in the Controller ....................................... 75
   Changing the State of an Output ................................................. 76
   Changing the State of a Flag ..................................................... 77

Index
Notes To Readers

The CTC Monitor™ User Guide provides the following information:

- Setting up and configuring computer - controller communications for CTC Monitor
- Monitoring controller resources and I/O devices
- Using a Data Table and symbolic names in CTC Monitor
- Creating and using register files
- Creating custom menus
- Using CTC Monitor as a DDE server

Related Documents

The following documents contain additional information

- For information on Quickstep, refer to the Quickstep™ Language and Programming Guide.
- For information on Quickstep editor user interface, refer to the Quickstep™ User Guide.
- For information on the registers in your controller, refer to Register Reference Guide.
- For information on your controller and its modules, refer to the appropriate Installation and Applications Guide.
- For information on Microsoft Windows or your PC, refer to the manuals provided by the vendor.

Book conventions
Notes to Readers

The following conventions are used in this book:

<table>
<thead>
<tr>
<th>ALL CAPS BOLDFACE</th>
<th>Identifies DOS, Windows, installation program file names.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boldface</td>
<td>Indicates information you must enter, an action you must perform, or a selection you can make on a dialog box or menu.</td>
</tr>
<tr>
<td>Italic</td>
<td>Indicates a word requiring an appropriate substitution. For example, replace filename with an actual file name. It can also indicate a manual, book, or chapter title.</td>
</tr>
<tr>
<td>Text_Connected_With_Underlines</td>
<td>Indicates symbol names used in Quickstep programs. Step names are ALL_CAPITALS. Other symbol names can be Initial_Capitals or lower_case.</td>
</tr>
<tr>
<td>SMALL CAPS</td>
<td>Identifies the names of Quickstep instructions in text.</td>
</tr>
<tr>
<td>Courier font</td>
<td>Identifies step names, comment, output changes, and Quickstep instructions appearing in the Quickstep editor window or program steps</td>
</tr>
<tr>
<td>ArtCode – DN-24</td>
<td>Identifies the file name of a particular graphic image.</td>
</tr>
</tbody>
</table>

How to Contact Control Technology Corporation

Control Technology Corporation is located in Massachusetts, and we are open from 8:30 a.m. to 5:00 p.m. eastern time. Contact us at 508 435-9595 and 800 282-5008 or Fax 508 435-2373


Your Comments

We welcome your suggestions and comments about this or any other Control Tech document. Comment forms are in the file called BUGRPT.WRI, which was installed in your QSWIN directory during your Quickstep installation. you can also email comments to techpubs@control.com.
Getting Started

Contents

Setting Up Computer–Controller Connections 2
Launching CTC Monitor 4
CTC Monitor Overview 6
Displaying Controller Configuration Information 10
Starting, Stopping, and Resetting the Controller 12
Setting Up Computer–Controller Connections

CTC Monitor can be set up to communicate with a controller through an RS-232 port or on an Ethernet network. In either case, you must have set up the physical connection between the computer running CTC Monitor and the controller you want to monitor before you can use CTC Monitor to monitor the controller.

Using the RS-232 Port for CTC Monitor – Controller Communications

Your controller is equipped with a built-in protocol allowing direct computer communications with the controller’s RS-232 port. This protocol is described in the Guide to CTC Serial Data Communications.

The connection to the controller’s RS-232 port is made via a modular jack on the controller (labelled COMM). This jack carries the receive signal, two grounds, and the transmit signal for the communications channel. The pin connection diagram illustrates the wiring of the jack. Only the center four conductors of a six-conductor jack are used. For more information, refer to the installation guide for your controller.

A series of standard Control Tech. cables are available for making connection to this jack (listed in the table below). As an alternative, many commonly-available telephone cables may be substituted.

If you have a Model 2600XM or 2700 controller you can also connect the computer to an RS-232 port on a Model 2216 or Model 2716 RS-232 Communications Module or a Model 2217 or 2719 Ethernet Module.

Connecting to a D Connector

RS-232 ports on computers are usually brought out through 25-pin or 9-pin D type connectors. There is a standard for wiring such connectors, followed by IBM and many other PC manufacturers.

Control Tech. has adapters available, the model 2880A or -B, that connect directly to a male 25-pin (-A version) or 9-pin (-B version) D connector. These adapters provide a modular jack wired for compatibility with the COMM port. To be fully compatible when using this adapter, the computer’s communications port should be wired as a DTE device:

- Pin 2 = TxD
- Pin 3 = RxD
- Pin 7 = Ground.

NOTE: Do not connect the controller to a telephone line.

The following table lists the part numbers for 25-pin or 9-pin D type connectors used for RS-232 connections.

<table>
<thead>
<tr>
<th>Model Number</th>
<th>Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>2280A</td>
<td>25-pin D connector</td>
</tr>
<tr>
<td>2280B</td>
<td>9-pin D connector</td>
</tr>
<tr>
<td>2881</td>
<td>5 foot communications cable</td>
</tr>
<tr>
<td>2882</td>
<td>15 foot communications cable</td>
</tr>
<tr>
<td>2883</td>
<td>25 foot communications cable</td>
</tr>
</tbody>
</table>
Using Ethernet for CTC Monitor – Controller Communications

Model 2600XM and 2700 controllers can access an ethernet network for controller-computer communications using an Ethernet module. The Model 2217 Ethernet module contains both 10Base2 and 10BaseT connections, as well as two RS-232 ports. The Model 2717 Ethernet module has ten 100BaseT connectors as well as two RS-232 ports. Using ethernet, you can use CTC Monitor to communicate with any controller in your network.

NOTE: Even though there can be multiple controllers on a network, you can only communicate with one controller at a time.

The connection to the controller Ethernet port uses for Ethernet IEEE 802.3 standard 10Base2, 10BaseT, and 100 BaseT connections. For additional information about setting up Ethernet communications, refer to the installation and applications Guide for your Ethernet module.
Launching CTC Monitor

As part of the installation, MONSETUP.EXE creates a CTC Monitor Utility icon in the CTC Tools program group. You can launch CTC Monitor as a standalone application or use it in conjunction with the Quickstep editor. To start CTC Monitor as a standalone application:

From the Start menu, select CTC Monitor from the CTC Tools Product group on the Programs menu. The CTC Monitor window appears.
To launch CTC Monitor when you are using the Quickstep editor:

1. Select **Monitor Controller** from the **Project** menu in the Quickstep editor.

   If you have previously used CTC Monitor to monitor a controller, the following box appears:

   ![CTC Monitor Utility Files Form](image)

   **Please select the files that you wish to load.**

   - [ ] Custom Form 1 file NOT defined.
   - [ ] Custom Form 2 file NOT defined.
   - [x] Symbol file C:\TEMP\~QS2.SYM
   - [ ] Data Table file NOT defined.

   ![Okay and Cancel buttons](image)

2. Select the appropriate response.

   The CTC Monitor window appears.

![CTC Monitor - COMM 1](image)

- **Registers**
- **Flags**
- **Servos**
- **Program Step Status**
- **Data Table**
- **NVRAM Module**
- **Connected to COMM 1**

![CTC Monitor window](image)
CTC Monitor Overview

CTC Monitor allows you to perform real time monitoring of a controller’s resources. The resources available for monitoring include:

- Flags
- Digital I/O
- Analog I/O
- Servo positions and errors
- Data Table
- All registers

You can configure the monitor program for either serial port access through COMM ports 1 to 8 (baud rate selectable) or through an Ethernet connection.

The monitor utility also has the following features:

- Displays a tree structure that shows the step numbers of the running tasks and allows you to monitor the controller’s program status.
- Allows real time data entry for registers with write access
- Allows real time data entry to flags, analog and digital outputs, and servo positions.
- Allows real time data entry for the Data Table and the ability to download a new Data Table into the controller.
- Contains a built-in DDE (dynamic data exchange) server that allows data exchange with another application (such as Excel) with your controller.
- You can define two custom screens that can group up to 16 resources of any type. These screens support bidirectional data transfer for the selected resources. You can also save the screens definitions to disk and recall them for later use.
- Imports and displays the symbolic names used in your Quickstep 2.x program.
- Uploads values stored in general purpose registers from 1 to 1000 and registers 32001 - 36000 into a text file, edit the values, and download them back to the controller.

**NOTE:** Only 2700 series controllers support registers 32001 through 36000.
CTC Monitor Window Overview

The following illustration shows the CTC Monitor window and describes the different parts of the window.

1. **Menu bar**
   - Contains the File, Configuration and Help menus. Opens a Symbol Table or register file, uploads/downloads a register file, configures CTC Monitor/controller communications, sets up DDE communications, and displays the on-line Help file.

2. **Selection buttons**
   - Accesses the register, input, analog input, flag, output, analog output, servo and custom menus for monitoring and changing resources.

3. **Program status**
   - Displays a listing, by tree structure, of the current running tasks in the controller being monitored.

4. **Data table**
   - Uploads or downloads a data table to and from the controller, change it, or open an existing Data Table.

5. **NVRAM module**
   - Accesses the registers available on the NV Ram module.

6. **Monitor button**
   - Toggles to suspend or resume communications between the controller and CTC Monitor.

7. **Controller status**
   - Displays status messages and user prompts.

8. **Command buttons**
   - Starts, stops, and resets the controller.
Configuring Computer–Controller Communications

Before you can use CTC Monitor to monitor your controller, you must indicate the type of communications used in the Configuration Setup dialog box. From this dialog box you can specify the communications port used for RS-232 communications or the computer and controller node numbers for Ethernet communications.

Configuring RS-232 Communications

To configure RS-232 communications:

1. From the Configuration menu select Change Configuration.

   The Communication Setup dialog box appears.

2. Click the arrow on the right side of the Communication Port field to display the choices for communications.

3. Select the communications port (COMM1 through COMM8).

4. Click the arrow on the right side of the Baud Rate Selected field to display the baud rates.

5. Select the baud rate. The default is 9600 baud.

6. Select Ok.

   Once CTC Monitor establishes communication with the controller, the Configuration Setup up dialog box displays information about the controller.
Configuring Ethernet Communications

To configure Ethernet communications:

1. From the Configuration menu select Change Configuration.

   The Configuration Setup dialog box appears.

   ![Communication Setup dialog box]

   - **Communication Port:** CTeNET
   - **Baud Rate Selected:** 9600
   - **IP Address:**
   - **Host Node:** 1
   - **Target Node:** 0
   - **Timeout (ms):** 250

   - **Number of Flags:** 32
   - **Number of Inputs:** 16
   - **Number of Outputs:** 48
   - **Number of Steppers:** 0
   - **Number of Servos:** 2
   - **Number of Analog Ins:** 0
   - **Number of Analog Outs:** 0
   - **Number of Prototype:** 0
   - **Number of HS Counters:** 0
   - **Number of Thumbwheels:** 0
   - **Number of Displays:** 0
   - **Controller Architecture:** EA

2. Click the arrow on the right side of the Communication Port field to display the choices for communications.

3. Select CTeNET, CTeUDP, or CTeTCP.

4. Enter the computer’s node number in the Host Node field.

5. Enter the controller’s node number in the Target Node field. The default value is 1.

6. Set the Timeout value. The default value is 250 ms.

7. Select Ok.

   Once CTC Monitor establishes communication with the controller, the Configuration Setup up dialog box displays information about the controller.
Displaying Controller Configuration Information

Once you have established communications with the controller, the Controller Configuration dialog box displays information about the controller. To display controller information, select Change Configuration from the Configuration menu.

![Communication Setup](image)

The Equipment List lists information about the various modules and resources the controller contains:

- Flags in the controller
- Digital inputs and outputs
- Stepping and servo motors
- Analog inputs and outputs
- Prototype modules, if any
- High speed counting modules
- Thumbwheels and numeric displays

It also lists the controller architecture code used by Control Tech.

The Operating Status lists the status of the controller’s dedicated inputs and operating status of the controller. This information only appears for model 2800iEA, 2800EAXM, and 2400iEA controllers.
The status indicators for the start, stop, reset, and step dedicated input change from idle to active when a switch closure occurs on the dedicated input. You cannot change the state of the dedicated inputs from this dialog box; that can only be done by turning the appropriate input on or off.

Operating Status also lists the following information:

- If the controller running, stopped, or waiting for an input
- If it is in normal mode
- If it status is Ok or if it has a fault condition
- Where the controller is in its program
Starting, Stopping, and Resetting the Controller

You can start, stop, or reset the controller from the CTC Monitor window by selecting the Start, Stop, or Reset buttons. Pressing one of these buttons sends a start, stop, or reset command directly to the controller. These buttons work independently from the dedicated inputs.
# Monitoring Controller Resources and I/O Devices

## Contents

- Monitoring Registers 14
- Monitoring Flags 16
- Monitoring Digital Inputs 18
- Monitoring Analog Inputs 20
- Monitoring Digital Outputs 22
- Monitoring Analog Outputs 24
- Monitoring Servo Motors 26
- Monitoring NVRam Module Registers 27
- Monitoring Program Step Status 29
Monitoring Registers

From the Register dialog box you can do the following:

- View the values stored in registers
- Store a new value in a register
- Store a value in an empty register.

You access the Register dialog box by selecting the Registers button on the CTC Monitor window. The following illustration shows the register dialog box.

<p>| | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Display</td>
<td>Toggles the register value list between decimal and Hex notation.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Register name list</td>
<td>Displays the register names. If you don’t choose a symbol table, the names displayed default to reg_ plus the register number (reg_10). When you select a symbol table, the list displays the symbol names for the registers. To display an entire symbol name, resize the window: only the name list will expand.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Register value list</td>
<td>Displays the current numeric value for the registers shown. When a new value is entered into the text box, CTC Monitor downloads the value to the corresponding register in the controller.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Register number list</td>
<td>Displays the register number.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-----------------------</td>
<td>-------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Register jump box</td>
<td>Allows you to change the range of registers displayed. Entering a register number in the jump box changes the range of registers displayed to start with the number entered. If you enter a number that exceeds the register listing, CTC Monitor displays the last range of available registers.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Notation indicator</td>
<td>Indicates if the current register values are in decimal or Hex notation.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** You can only enter numbers as decimal values even if the Register dialog box is displaying values as Hex notation.

**Viewing Register Values**

To view the values stored in registers, select the **Registers** button on the **CTC Monitor window**. The Registers dialog box appears.

To display a new range of registers, enter the number of the register in the **Register Jump Box** and press **Enter**.

**Changing or Entering the Value in a Register**

To enter or change a value in a register:

1. Select the **Registers** button on the **CTC Monitor window**.

   The Register dialog box appears.

2. If necessary, enter the number of the register in the **Register Jump Box** and press **Enter**.

3. Select the register box by double clicking it with the mouse.

   ![Register values](image)

4. Type the new value.

   ![Register values](image)

5. Press **ENTER**.

   CTC Monitor downloads the new value to the controller.
Monitoring Flags

From the Flags dialog box you can view or change the status of a flag. You access the Flag dialog box by selecting the Flags button on the CTC Monitor window. The following illustration shows the Flag dialog box:

1. Flag name list - Displays the flag names. If you don’t choose a symbol table, the names displayed default to flag_ plus the flag number (flag_2). When you select a symbol table, the list displays the symbolic names for the flags. To display an entire symbolic name, resize the window: only the name list will expand.

2. Flag state button/list - Displays the current state for the flags shown. Flags are either set or clear. When you change the state of a flag, CTC Monitor downloads the new state to the corresponding flag in the controller.

3. Flag number list - Displays the flag number.

4. Flag jump box - Allows you to change the range of flags displayed. Entering a flag number in the jump box changes the range of flags displayed to start with the number entered. If you enter a number that exceeds the flag listing, CTC Monitor displays the last range of available flags.
Viewing Flag States

To view the state of a flag, select the **Flags** button on the **CTC Monitor window**. The Flags dialog box appears.

To display a new range of flags, enter the number of the flag in the **Flag Jump Box** and press **Enter**.

Changing the State of a Flag

To change a flag’s state:

1. Select the **Flags** button on the **CTC Monitor window**.
   The Flags dialog box appears.
2. If necessary, enter the number of the Flag in the **Flag Jump Box** and press **Enter**.
3. Use the mouse pointer to click the **State Button** of the flag whose state you want to change.

<table>
<thead>
<tr>
<th>Top_Axis_in_Motion</th>
<th>Set 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom_Axis_in_M</td>
<td>Set 2</td>
</tr>
<tr>
<td>flag_3</td>
<td>Clear 3</td>
</tr>
<tr>
<td>flag_4</td>
<td>Set 4</td>
</tr>
<tr>
<td>flag_5</td>
<td>Clear 5</td>
</tr>
</tbody>
</table>

   The State Button changes and CTC Monitor downloads the changed state to the controller.
## Monitoring Digital Inputs

The Digital Input dialog box allows you to monitor the current state of digital inputs. You access the Digital Input dialog box by selecting the Input button on the CTC Monitor window. The following illustration shows the Digital Input dialog box:

![Digital Input Dialog Box](image)

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Digital input list</td>
<td>Displays the names of the digital inputs. If you don’t choose a symbol table, the names displayed default to <code>in_</code> plus the input number and A for open inputs, or B for closed inputs (<code>in_1A</code> or <code>in_2B</code>). When you select a symbol table, the list displays the symbolic names for the inputs. To display an entire symbolic name, resize the window: only the name list will expand.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Digital input State Buttons/ List</td>
<td>Displays the current state for the digital inputs shown. ON means that the digital input is currently pulled to Ground; OFF means that the digital input is currently at + 24 volts.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Digital input number list</td>
<td>Displays the input number.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Digital input jump box</td>
<td>Allows you to change the range of inputs displayed. Entering an input number in the jump box changes the range of digital inputs displayed to start with the number entered. If you enter a number that exceeds the digital input listing, CTC Monitor displays the last range of available digital inputs.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Viewing Input States

To view the state of a input, select the Inputs button on the CTC Monitor window. The Digital Inputs dialog box appears.

To display a new range of inputs, enter the number of the input in the Digital Input Jump Box and press Enter.
Monitoring Analog Inputs

The Analog Input dialog box allows you to monitor the current value of an analog input. You access the Analog Input dialog box by selecting the Analog Ins button on the CTC Monitor window. The following illustration shows the Analog Input dialog box:

1 Analog input list Displays the names of the analog inputs. If you don’t choose a symbol table, the names displayed default to ain_ plus the analog input number (ain_1). When you select a symbol table, the Register menu displays the symbolic names for the inputs. To display an entire symbolic name, resize the window: only the name list will expand.

2 Analog input number list Displays the numeric value for the analog input.

3 Analog input number list Displays the input number.

4 Analog input jump box Allows you to change the range of analog inputs displayed. Entering a number in the jump box changes the range of analog inputs displayed to start with the number entered. If you enter a number that exceeds the analog input listing, CTC Monitor displays the last range of available analog inputs.

Viewing Analog Input Values
To view the state of a input, select the Analog Ins button on the CTC Monitor window. The Analog Inputs dialog box appears.

To display a new range of inputs, enter the number of the input in the Analog Input Jump Box and press Enter.
**Monitoring Digital Outputs**

The Digital Output dialog box allows you to view the state of a digital output or turn it on and off. You access the Digital Output dialog box by selecting the Output button on the CTC Monitor window. The following illustration shows the Digital Output dialog box:

![Digital Outputs Dialog Box](image)

1. **Digital output list**
   - Displays the names of the digital outputs. If you don’t choose a symbol table, the names displayed default to `OUT_` plus the output number and on or off (`OUT_1_OFF`). When you select a symbol table, the list displays the symbol names for the outputs. To display an entire symbol name, resize the dialog box: only the name list will expand.

2. **Digital output State Buttons/ List**
   - Displays the current state for the digital outputs shown. Digital outputs are either on or off. When you turn an output on or off, CTC Monitor downloads the new state to the controller, and the controller changes the state of the corresponding output.

3. **Digital output number list**
   - Displays the output number.

4. **Digital output jump box**
   - Allows you to change the range of outputs displayed. Entering an output number in the jump box changes the range of digital outputs displayed to start with the number entered. If you enter a number that exceeds the digital output listing, CTC Monitor displays the last range of available digital outputs.
Viewing Output States

To view the state of an output, select the Outputs button on the CTC Monitor window. The Outputs dialog box appears.

To display a new range of outputs, enter the number of the output in the Output Jump Box and press Enter.

Turning Digital Outputs On and Off

To turn change the output on or off:

1. Select the Outputs button on the CTC Monitor window.
   The Digital Outputs dialog box appears.
2. If necessary, enter the number of the output in the Digital Output Jump Box and press Enter.
3. Use the mouse pointer to click the State Button of the output you want to turn on or off.

```
| Out 1 Off  | Off | 1 |
| Out 2 Off  | Off | 2 |
| Out 3 On   | On  | 3 |
| Out 4 Off  | Off | 4 |
| Out 5 On   | On  | 5 |
```

The State Button changes and CTC Monitor downloads the changed output state to the controller.

```
| Out 1 Off  | Off | 1 |
| Out 2 On   | On  | 2 |
| Out 3 On   | On  | 3 |
| Out 4 Off  | Off | 4 |
| Out 5 On   | On  | 5 |
```
Monitoring Analog Outputs

From the Analog Output dialog box you can monitor the current value of analog outputs and change their values. You access the Analog Output dialog box by selecting the Analog Outs button on the CTC Monitor window. The following illustration shows the Analog Output dialog box:

1. Analog output list: Displays the names of the Analog outputs. If you don’t choose a symbol table, the names displayed default aout_ plus the analog output number(aout_2). When you select a symbol table, it displays the symbolic names for the outputs. To display an entire symbolic name, resize the dialog box: only the name list will expand.

2. Analog output value list: Displays the current value for the analog outputs shown. When you enter a new value for an output, CTC Monitor downloads the new value to the controller, and the controller enters the new value in the corresponding output.

3. Analog output number list: Displays the output number.

4. Analog output jump box: Allows you to change the range of analog outputs displayed. Entering a number in the jump box changes the range of analog outputs displayed to start with the number entered. If you enter a number that exceeds the analog output listing, CTC Monitor displays the last range of available analog outputs.
Viewing Current Analog Output Values

To view the value of an analog output, select the Analog Outs button on the CTC Monitor window. The Analog Outputs dialog box appears.

To display a new range of outputs, enter the number of the output in the Analog Output Jump Box and press Enter.

Changing Analog Output Values

To change an output value:

1. Select the Analog Outs button on the CTC Monitor window.
   The Analog Outputs dialog box appears.

2. If necessary, enter the number of the output in the Analog Output Jump Box and press Enter.

3. Use the mouse pointer to select the analog output whose value you want to change.

   | aout_1 | 1000 | 1 |
   | aout_2 | 2200 | 2 |
   | aout_3 | 1600 | 3 |
   | aout_4 | 0    | 4 |

   Mon27

4. Type the new value.

5. Press Enter.

   CTC Monitor downloads the new value to the controller.

   | aout_1 | 1000 | 1 |
   | aout_2 | 2200 | 2 |
   | aout_3 | 1400 | 3 |
   | aout_4 | 0    | 4 |

   Mon28
Monitoring Servo Motors

The Servo Motors dialog box allows you to view the current position of a servo motor and monitor the servo error. You access the Servo Motor dialog box by selecting the Servos button on the CTC Monitor window. The following illustration shows the Servo Motor dialog box:

1 Servo output list Displays the servo names. If you don’t choose a symbol table, the names default to servo_ plus the servo number(servo_1). When you select symbol table, the list displays the symbolic names. To display an entire symbolic name, resize the dialog box: only the name list will expand.

2 Servo Position list Displays the current servo position.

3 Servo error value list Displays the current error value for the servos.

Viewing Servo Position and Error Values

To view servo position and error values, select the Servos button on the CTC Monitor window. The Servo Motors dialog box appears.
Monitoring NVRam Module Registers

From the NVRAM Module dialog box you can do the following:

- View the values stored in the NVRAM registers 32001 through 48000
- Store a new value in a the NVRAM register
- Store a value in an empty the NVRAM register.

You access the NVRAM Module dialog box by selecting the NVRAM Module button on the CTC Monitor window. The following illustration shows the NVRAM Module dialog box.

![NVRAM Module](image)

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Register name list</td>
</tr>
<tr>
<td>2</td>
<td>Register value list</td>
</tr>
<tr>
<td>3</td>
<td>Register number list</td>
</tr>
<tr>
<td>4</td>
<td>Register jump box</td>
</tr>
</tbody>
</table>
Monitoring NV Ram Module Registers

Viewing an NVRAM Module Register Values

To view the values stored in registers, select the **NVRAM Module** button on the **CTC Monitor window**. The NVRAM Module dialog box appears.

To display a new range of registers, enter the number of the register in the **Register Jump Box** and press **Enter**.

Changing or Entering the Value in an NVRAM Module Register

To enter or change a value in an NVRAM Module register:

1. Select the **NVRAM Module** button on the **CTC Monitor window**. The NVRAM Module dialog box appears.
2. If necessary, enter the number of the register in the **Register Jump Box** and press **Enter**.
3. Select the register box by double clicking it with the mouse.

   ![Register Table](image)

4. Type the new value.

   ![Register Table](image)

5. Press **ENTER**. CTC Monitor downloads the new value to the controller.
Monitoring Program Step Status

CTC Monitor gives you real time monitoring of your Quickstep program. The Program Status dialog box displays a list of the current running tasks. You access the Program Status dialog box by selecting the Program Step Status button on the CTC Monitor window. The following illustration shows the Program Status dialog box:

1 Program task list
   Shows the tree structure of the current tasks running in the controller. The current step number and symbolic step name are displayed for each task.

2 Program status list
   Displays the current status of the controller being monitored. Any software faults and or changes in controller status will be displayed in this message area.

Monitoring Program Tasks

To view a tree structure of the current tasks and to monitor program status, select the Program Step Status button on the CTC Monitor window. The Program Status dialog box appears.

Reading System Fault Messages

When your controller has a fault condition, the Program Status List displays messages that can help you diagnose the problem. The Program Status List displays the step where the fault occurred and a message. A list of system default messages is on the next page.

To obtain a system fault message, select the Program Step Status button on the CTC Monitor window. The Program Status dialog box appears. To see an entire fault message, expand the dialog box to full size and read the message in the program status list.

Controller Software Faulted in step 3! 11 Servo# 1 Is Not Ready
Monitoring Program Step Status

The following is a list of system fault messages:

1. Illegal Function
2. Corrupt Program Data
3. Destination Step is Empty
4. Bad Thumbwheel Data
5. Step#1 is Empty
6. Too Many Tasks
7. No Such Stepper Motor
8. Motor Not Ready
9. Motor Unprofiled
10. Servo# does NOT exist
11. Servo# Is Not Ready
12. Servo# Error
13. Register# does NOT exist
14. Data Table Column# does NOT exist
15. Data Table Row# does NOT exist
16. No Such Proto Board
17. Illegal Sample Time
18. Analog Input# does NOT exist
19. Analog Output# does NOT exist
20. Display# does NOT exist
21. Digital Input# does NOT exist
22. Digital Output# does NOT exist
23. Thumbwheel# does NOT exist
24. Illegal Data Table Value
25. Message Transmitting Busy
26. Divide-By-Zero Error
27. Caused by Register# or Data Out Of Range
28. Watch dog / Hardware Fault
29. Error Network Fault
30. Network Access Timeout
Chapter 3

Working with Symbol Tables and Register Files

Contents

File Menu Overview 32
Opening a Symbol Table 33
Opening a Register File 34
Uploading Register Data and Creating a File 35
Downloading a Register File 36
File Menu Overview

From the File Menu you can do the following:

- Open a symbol table to use with CTC Monitor
- Open a register file
- Upload register values from the controller to create a register file
- Download a register file to the controller

You access the File menu by selecting File on the CTC Monitor main window. The following illustration shows the file menu:

- **Open Symbol File**: Opens an existing symbol table. When you select a symbol table, CTC Monitor creates a database of symbols and uses it in the symbolic names to identify controller resources.

- **Open Register File**: Opens an existing register file using Notepad. Register files must be text (.TXT) files.

- **Upload Registers**: Uploads the current register values from registers 1 through 1000 and registers 32001 through 36000 from the connected controller and creates a text (.TXT) file.

Model 2601, 2600, and 2700 controllers all contain 1000 general purpose registers. Some older controllers do not contain 1000 general purpose registers. Refer to the installation guide for your controller.

If you have an NVRAM module installed, CTC Monitor uploads the values in registers 32001 through 36000. It does not upload the values in registers 36001 through 48000.

- **Download Registers**: Downloads an existing register file into the controller. CTC Monitor requires text (.TXT) files for downloading.
Opening a Symbol Table

From CTC Monitor you can open a symbol table and use the symbolic names from a symbol table with the Quickstep program you are monitoring.

To select an existing symbol table and use it with CTC Monitor:

1. Select **Open Symbol File** from the **File** menu.
2. When the Open dialog box appears, select the symbol table you want, changing directories if necessary.
3. Using the mouse click **OK** or press **Enter** to load the symbol table.
Opening a Register File

From CTC Monitor you can open an existing register file and display it using Notepad. A register file lists the register numbers and their values and must be a text (.TXT) file.

To select an existing register file and view it using Notepad:

1. Select **Open Register File** from the **File** menu.

2. When the Open dialog box appears, select a *filename* from the **File Name** list, changing directories, if necessary.

3. Using the mouse click **OK** or press **Enter** to open Notepad and display the register file.

   Notepad displays the register file.
Uploading Register Data and Creating a File

From CTC Monitor you can upload the current register values from registers 1 to 1000 and 36001 to 36000 from your controller and create a (.TXT) files.

Model 2601, 2600, and 2700 controllers all contain 1000 general purpose registers. Some older controllers do not contain 1000 general purpose registers. Refer to the installation guide for your controller.

If you have an NVRAM module installed, CTC Monitor uploads the values in registers 32001 through 36000. It does not upload the values in registers 36001 through 48000.

You must have version 2.7.1 of CTC Monitor to upload and download the values in registers 26001 to 36000. To obtain the most recent version of CTC Monitor download it from the customer area of the website.

To upload register values and create a register file:

1. Select Upload Register File from the File menu.

2. When the Save As dialog box appears, enter a filename, changing directories, if necessary

3. Using the mouse click OK or press Enter to save the register file.
Downloading a Register File

From CTC Monitor you can download an existing register file and place the values into registers 1 through 1000 and registers 36001 through 36000 of your controller. The Register files must be text (.TXT) files.

Model 2601, 2600, and 2700 controllers all contain 1000 general purpose registers. Some older controllers do not contain 1000 general purpose registers. Refer to the installation guide for your controller.

If you have an NVRAM module installed, CTC Monitor uploads the values in registers 32001 through 36000. It does not upload the values in registers 36001 through 48000.

You must have version 2.7.1 of CTC Monitor to upload and download the values in registers 26001 to 36000. To obtain the most recent version of CTC Monitor download it from the customer area of the website.

To select an existing register file and download it to your controller:

1. Select **Download Register File** from the **File** menu.

2. When the Open dialog box appears, select a **filename** from the **File Name** list, changing directories, if necessary.

3. Using the mouse click **OK** or press **Enter** to download the register file.

   The Status Message display lists the registers as CTC Monitor downloads them to the controller. When CTC Monitor is finished downloading the register file, the message, “Register write completed.” appears in the Status Message display along with the number of the highest register downloaded.
Working with the Data Table Dialog Box

Contents

Data Table Dialog Box Overview 38
Entering Numbers and Messages 42
Realtime Data Table Monitoring 43
Data Table Dialog Box Overview

From the Data Table dialog box you can do the following:

- Load an existing a data table into the CTC Monitor workspace
- Save a data table
- Upload a data table from the controller
- Download new values or messages to the data table in the controller
- Cut, copy, and paste items in the data table
- Monitor the data table in the controller
- Specify the time interval used when monitoring a data table
- Specify the starting and ending rows of the data table to monitor

You access the Data Table dialog box by selecting the data table button on the CTC Monitor window. The following illustration shows the Data Table dialog box:
<table>
<thead>
<tr>
<th></th>
<th>Menu bar</th>
<th>Contains the File, Edit and Option menus. These menus allow you to open, save, upload or download a data table and edit the contents of the data table. You can also start, stop, set up data table monitoring.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Toolbar</td>
<td>Gives you quick mouse access to many tools used in the Data Table dialog box.</td>
</tr>
<tr>
<td>3</td>
<td>Data table rows and columns</td>
<td>Displays the rows and columns in your data table. The data table is a two-dimensional array of numbers.</td>
</tr>
<tr>
<td>4</td>
<td>Message list</td>
<td>Displays the ASCII character representation of the data in each row of the table. You can use this area to create messages for transmission to external devices.</td>
</tr>
</tbody>
</table>

**The Toolbar**

The Toolbar appears across the top of the Data Table dialog box below the menu bar and contains the following tools:

- **Open Existing File** - Opens an existing data table.
- **Save** - Saves the data table using its current name.
- **Cut** - Removes the selected text and places it on the Clipboard.
- **Paste** - Inserts the contents of the Clipboard in the data table.
- **Copy** - Copies the selected text and places it on the Clipboard.

**Rows:**

- **Rows:** Indicates the number of rows in the data table.

**Cols:**

- **Cols:** Indicates the number of columns in the data table.
Data Table Dialog Box Overview

Saving an Existing Data Table

To save a data table:

Do one of the following:

- Select Save from the File menu (shortcut, type CTRL + S).
- Select the Save icon on the Toolbar.

Changing the Font

The data table editor displays text in Courier font. You can change the default font using the Font dialog box.

1. Select Font from the Options menu.

2. When the Fonts dialog box appears, select the Font, Font Style, Size, and Color.

   ![Font Dialog Box]

   The Sample box displays the current font.

   NOTE: We do not recommend selecting the Strikeout or Underline effects.

3. Select OK to apply your changes.

   To exit without saving your changes, select Cancel.
Opening a Data Table File

From the Data Table dialog box you can open an existing data table.

To open an existing data table:

1. Select **Open** from the **File** menu.

   The Load Data Table dialog box appears.

   ![Load Data Table Dialog Box]

   2. Choose the name of the data table from the Load Data Table dialog box and select **OK**. If the data table is in a different directory, select the appropriate directory.

   CTC Monitor opens the data table.

Uploading and Downloading a Data Table

From CTC Monitor you can upload or download a data table from your controller to the CTC Monitor Data Table dialog box. If there is not a data table open, use the Open command from the File menu.

- To upload a data table, select **Upload** from the **File** menu. The uploaded data table appears in the Data Table dialog box and the message, **Upload complete**, appears in the Status Message Display on the CTC Monitor Main window.

- To download a data table, select **Download** from the **File** menu. When CTC Monitor has finished downloading the data table, the message, **Download complete**, appears in the Status Message Display on the CTC Monitor Main window.
Entering Numbers and Messages

Entering and Editing Numbers in the Data Table

You can enter or edit a number by typing from the keyboard or pasting it from the Clipboard.

To enter or edit a value:
1. Select the appropriate cell using the Arrow keys or mouse pointer.
   The data table editor highlights the cell.
2. Type or paste the number and press Enter.
   The number appears in the cell.
3. To enter a value in another cell, press Enter again to move to the next cell in a row. You can also use the Arrow keys or mouse pointer to move to the another cell.
4. To send the new values to the controller, select **Download** from the **File** menu.

Entering Messages

Using the Data Table dialog box, you can create messages for the data table. The length of message (letters, numbers, and spaces) cannot be longer than the number of columns in the table.

To enter a message:
1. Select the message field by placing the mouse cursor in the message field and click the mouse.

```
.............
............. Mon41
```

The dots in the message indicate that the corresponding cell in the data table does not contain a number which is an ASCII code for a printing character.

2. Type the message and press Enter.
   CTC Monitor enters the message in the Data Table dialog box.

```
.............
Fill process done...
............. Mon42
```

3. To send the message to the controller, select **Download** from the **File** menu.
Realtime Data Table Monitoring

CTC Monitor also gives you real time monitoring of a data table. Using the data table monitoring, you can check the current values in a data table while your controller is running.

Setting the Data Table Monitor Parameters

Using the Monitor Setup dialog box, you can specify the monitor time interval and the beginning and ending rows to be monitored. You access this dialog box by selecting Monitor Setup from the Options menu. The following illustration shows the Monitor Setup dialog box.

Monitor Interval: Specifies the data table monitor interval in milliseconds. The default time interval is 2000 milliseconds (2 seconds).

Starting Row to Monitor: Specifies the starting row to monitor. CTC Monitor only updates the data table rows specified. Specifying the rows to monitor allows for the maximum update speed available.

Ending Row to Monitor: Specifies the ending row to monitor. CTC Monitor only updates the data table rows specified.

To set the monitor parameters:

1. Select Monitor Setup from the Options menu. Then set the time interval, starting and ending rows as necessary.

2. To specify the time interval, place the mouse pointer on the Monitor Interval field and double click the mouse.

3. Type the time interval and press Enter.

4. To specify the starting or ending row to monitor, place the mouse pointer on the Starting Row to Monitor or Ending Row to Monitor field and double click the mouse.

5. Type the row number and press Enter.
Realtime Data Table Monitoring

Starting and Ending Data Table Monitoring

When data table monitoring begins, CTC Monitor uploads data table from the controller and displays it in the Data Table dialog box. CTC Monitor will upload the data table at the time interval specified in the Monitor Setup dialog box. When you cancel data table monitoring, the Data Table dialog box continues to display the last uploaded data table.

You can start and stop monitoring a data table as follows:

- To begin data table monitoring, select **Begin Monitoring** from the **Options** menu.
- To end data table monitoring, select **End Monitoring** from the **Options** menu.
Creating Custom Dialog Boxes

Contents

Custom Display Dialog Box Overview 46
Creating a Custom Dialog Box 50
Custom Display Dialog Box Overview

CTC Monitor gives you the option of creating custom dialog boxes that allow you to monitor a variety of controller resources, inputs, outputs, and servo positions and errors values. To access the custom dialog boxes select the Custom 1 or Custom 2 buttons on the CTC Monitor window. Each custom dialog box can list up to 16 different resources. You can create custom dialog boxes and save them for monitoring different machines or processes.

There are two different Custom Display dialog boxes. The Resource Display dialog box is for creating custom dialog boxes, and the Label Display dialog box is used to view the information.

Resource Display Dialog Box

The following illustration shows the Resource Display dialog box:

1. File menu
   Contains commands that allow you to create a new custom resource dialog box, save a new or existing dialog box, and exit the Custom Resource dialog box.

2. Display menu
   Allows you to toggle between the Resource Display and Label Display dialog boxes.

3. Resource list
   Displays a drop down list of controller resources. When you select a resource, CTC Monitor evaluates the resource number to make sure it is a valid resource. The custom resource value list field immediately displays the current value or state of the resource.
4 Resource number list
   Specifies and displays the number for the controller resource chosen. You enter the number of the resource you want in the appropriate text box. When you enter the new resource number, the custom resource value list field immediately displays the current value or state of the resource.

5 Resource value list
   Displays the current value for the controller resource chosen. You may enter new values or change the state of controller resources that accept input.

Label Display Dialog Box

The following illustration shows the Label Display dialog box.

1 File menu
   Contains commands that allow you to create a new custom resource dialog box, save a new or existing dialog box, and exit the Custom Resource dialog box.

2 Display menu
   Allows you to toggle between the Resource Display and Label Display dialog boxes.

3 Resource list
   Displays a list of controller resources using their symbolic names.

3 Resource value list
   Displays the current value for the controller resource. You may enter new values or change the state of controller resources that accept input.
Custom Display Dialog Box Overview

Changing Values in a Custom Dialog Box

Whenever CTC Monitor is communicating with a controller, the fields on the Resource Value list display the current value or state of the resources on the custom dialog box. You can change a value in a register or analog output or change the state of a flag or digital output from a custom dialog box.

1. Place the mouse pointer in the Resource Value field and click the mouse.
2. Type in the new value or state of the resource and press the Enter.

Saving a New Custom Dialog Box

To save a new custom dialog box:

1. Select Save as or Save from the File menu.
2. When the Save As dialog box appears, enter a name for the new dialog box.

3. If necessary, select the correct directory.
4. Select OK.

Saving an Existing Custom Dialog Box

To save an existing custom dialog box, select Save from the File menu.
Opening a Custom Dialog Box

You can display previously defined and saved custom dialog box by opening it.

To open a custom dialog box:
1. Select **Custom 1** or **Custom 2** from CTC Monitor window.
2. When the Resource Display dialog box appears, select **Open** from the **File** menu.

When the Open dialog box appears, select the file you want to open. If necessary, select a different directory.

3. Select **OK** or press **Enter**.
Creating a Custom Dialog Box

When you create a new custom display dialog box, you start with an empty Resource Display dialog box.

To create a new custom display dialog box:

1. Select Custom 1 or Custom 2 button on the CTC Monitor window.
2. When the Label Display dialog box appears, select Display Resources from the Display menu.
3. Display the drop down list of controller resources, by clicking on the Not Selected field with the mouse.

4. Choose a resource from drop down list of controller resources.
5. Select the Resource Number field by placing the mouse pointer in the field and clicking the mouse.
6. Type in the number of the resource and press Enter.

The Resource Value field immediately displays the current value or state of the resource.

7. Continue selecting resources until you have defined your custom dialog box.
8. To save the dialog box, select Save from the File menu and enter a name for the dialog box.
Using CTC Monitor as a DDE Server

Contents

Overview of the DDE Setup Dialog Boxes 52
Opening a DDE Communications Channel 56
Reading Register Values Using a DDE Application 57
Reading a Flag’s State from a DDE Application 62
Writing Register Values Using a DDE Application 63
Changing a Flag’s State from a DDE Application 65
Overview of the DDE Setup Dialog Boxes

From CTC Monitor you can use dynamic data exchange (DDE) to transfer information and communicate with another application, such as WonderWare™, Interlutions Fix™, Labview™, or Excel™. The DDE protocol permits two applications to communicate by continuously and automatically exchanging data through a DDE channel.

To establish DDE communications you must establish a channel, select a topic, request and send data. The DDE channel must be specified in both applications in order for them to exchange data.

There are two different DDE dialog boxes, the Flag Register Configuration dialog box and the Block Write Configuration dialog box.

Flag Register Configuration Dialog Box

From the Flag Register Configuration dialog box you can set up a DDE conversation that can read or change a specific flag or register. From this dialog box you can also read the state of all the flags and specify a block of 50 registers to be read at one time. The fields on the Flag Register Configuration dialog box are shown below.
To set up a DDE conversation you must specify the application, the DDE topic, and the item you want to set up a DDE link with. The table lists the application, topic, and item for the Flag Register Configuration dialog box:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>DDE Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Flag Write Address</td>
<td>Sets the flag address to write data to a specific flag. The DDE conversation must establish the correct flag address here before sending the new data to the Single Register Write Data box.</td>
<td>Application: CTCMON Topic: DdeSetup Item: FlagAddress</td>
</tr>
<tr>
<td>2 Flag Write Data</td>
<td>Displays the current state of the flag specified in the Flag Write Address box. If the flag is set, its value is 1; if the flag is clear, its value is 0.</td>
<td>Application: CTCMON Topic: DdeSetup Item: FlagWrite</td>
</tr>
<tr>
<td>3 Flag Data List</td>
<td>Displays the flag data. If the flag is set, its value is 1; if the flag is clear, its value is 0.</td>
<td>Application: CTCMON Topic: DdeSetup Item: FlagValue (1 - 32, 0 = inactive)</td>
</tr>
<tr>
<td>4 Single Register Write Address</td>
<td>Allows you to set the register address so that the DDE conversation can write data to a specific register. The DDE conversation must establish the correct register address here before sending the new data.</td>
<td>Application: CTCMON Topic: DdeSetup Item: RegAddress</td>
</tr>
<tr>
<td>5 Single Register Write Data</td>
<td>Allows the DDE conversation to change the value for the register specified in the Single Register Write Address box.</td>
<td>Application: CTCMON Topic: DdeSetup Item: RegWrite</td>
</tr>
<tr>
<td>6 Single Register Read Data</td>
<td>Displays the current value of the register specified in the Single Register Write Address box.</td>
<td>Application: CTCMON Topic: DdeSetup Item: RegRead</td>
</tr>
<tr>
<td>7 50 Register Block Read Address</td>
<td>Specifies a block of 50 registers to read. The data for the 50 register block selected is displayed in the Register Data listing. Register block addressing may be used to read registers 1 - 1000. Since the registers are displayed in blocks of 50, you must enter a value from 1 to 20 to access the corresponding block of registers. For example, entering 13 would display the values in registers 601 through 650.</td>
<td>Application: CTCMON Topic: DdeSetup Item: Reg50Address</td>
</tr>
<tr>
<td>8 Register Data List</td>
<td>Displays the data for the register block selected in the 50 register read address box.</td>
<td>Application: CTCMON Topic: DdeSetup Item: RegValue (1 - 50, 0 = inactive)</td>
</tr>
</tbody>
</table>
Overview of the DDE Setup Menu

Block Write Configuration Dialog Box

From the Block Write Configuration dialog box you can specify a set of up to 16 registers to read and write to as a block. These registers can be any register in the controller you have read or write access to. The following illustration lists the fields on the Block Write Configuration dialog box.

To set up a DDE conversation you must specify the application, the DDE topic, and the item you want to set up a DDE link with. The table lists the application, topic, and item for the Block Write Configuration dialog box.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>DDE Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Update Interval</td>
<td>Displays the current update time in milliseconds that the DdeSetup screen uses to update its controls. A value from 10 ms to 10000 ms (0.01 to 10 seconds) may be entered using the scroll bar. 200 ms or greater interval recommended.</td>
<td>Application: CTCMON Topic: DdeSetup Item: DdeInterval</td>
</tr>
<tr>
<td>2 Network Node Number</td>
<td>Displays the Ethernet node number of the controller CTC Monitor is communicating with.</td>
<td>Application: CTCMON Topic: DdeSetup Item: DDENode (1 - 32767)</td>
</tr>
<tr>
<td>3 Message Area</td>
<td>Displays the current state of the monitor program communication with your controller.</td>
<td>Application: CTCMON Topic: DdeSetup Item: Message</td>
</tr>
<tr>
<td>4 Start/Cancel Button</td>
<td>Toggles between the monitoring of the controller and the updating of the DDE Setup screen. Any DDE conversation that supports command execution can access this button.</td>
<td>Application: CTCMON Topic: DdeSetup Item: START</td>
</tr>
<tr>
<td>5 EXIT Button</td>
<td>Exits the DDE Setup screen and returns to the CTC Monitor main screen. Any DDE conversation that supports command execution can access this button.</td>
<td>Application: CTCMON Topic: Ddesetup Item: EXIT</td>
</tr>
<tr>
<td>6 Block Register Address</td>
<td>Allows you to specify which register addresses to write data to during a Block Register Write operation.</td>
<td>Application: CTCMON Topic: DdeSetup Item: BlockAddress (1 - 16, 0 = inactive)</td>
</tr>
<tr>
<td>7 Block Register Write Value</td>
<td>Allows DDE conversations to change the value for the registers specified in the Block Register Address boxes.</td>
<td>Application: CTCMON Topic: DdeSetup Item: BlockWrite (1 - 16)</td>
</tr>
<tr>
<td>8 Block Register Read Value</td>
<td>Displays the values for the register specified in the block register address shown.</td>
<td>Application: CTCMON Topic: DdeSetup Item: BlockRead (1 - 16, 0 = inactive)</td>
</tr>
<tr>
<td>9 Write Block Data Button</td>
<td>Writes all block write register data changes. Any DDE conversation that supports command execution can access this button. For applications that do not support command execution through DDE conversations, you can duplicate the action of this button by writing the value 1 to the hidden WriteBox control.</td>
<td>Application: CTCMON Topic: DdeSetup Item: DOWNLOAD Item: WriteBox</td>
</tr>
</tbody>
</table>
Opening a DDE Communications Channel

To establish DDE communications you must establish a channel, select a topic, and request and send data. Depending on what type of information you want, you may either leave the channel open to receive continual updates from the controller via CTC Monitor or you can close the channel after the initial data exchange. The DDE channel must be specified in both applications in order to exchange data.

You open a DDE channel and establish communications from the Block Write Configuration dialog box.

1. Start CTC Monitor.
2. Select DDE Setup from the Configuration menu.
3. When the DDE Configuration dialog box appears, select the tab for the Block Write Configuration dialog box.
4. Enter the update interval in the DDE Update Interval field.
   The update interval is specified in milliseconds. CTC does not recommend using an interval shorter than 200 milliseconds.
5. Select the Start DDE button by clicking it with the mouse.
Reading Register Values Using a DDE Application

The following example shows how to use set up CTC Monitor and a DDE application so that the DDE application can read register values from CTC Monitor. It uses an Excel spreadsheet. The example creates a report which tallies production results for the month and for the previous day.

Our report lists:

- The total number of widgets produced this month and on the previous day
- How many widgets failed the stress test this month and on the previous day
- How many widgets failed the pressure test this month and on the previous day
- How many times on the previous day did the widget manufacturing machine jam and have to be reset

The information for this report is stored in registers 701 to 708 as follows:

- Register 701: Monthly_Widget_Total
- Register 702: Daily_Widget_Total
- Register 703: Monthly_Stress_Failure
- Register 704: Daily_Stress_Failure
- Register 705: Monthly_Pressure_Failure
- Register 706: Daily_Pressure_Failure
- Register 708: Daily_Machine_Resets

Reading Register Values

To read register values from the controller via a DDE link to CTC Monitor, follow these general steps:

1. Set up the Flag Register or Block Write Configuration dialog boxes by specifying the registers you want the DDE application to read.
2. Set up and establish the DDE communications channel from CTC Monitor.
3. Set up the DDE application to read the registers.
4. Connect the DDE application to CTC Monitor.
Reading Register Values Using a DDE Application

Setting up the Flag Register Configuration Dialog Box

The first step is to set up the DDE configuration in CTC Monitor. In this example we show how to read register values from the Flag Register Configuration dialog box. Register values are read from the Register Data List. This list is an array of 50 register values, and the DDE link to it is:

- **Application:** CTCMON
- **Topic:** DdeSetup
- **Item:** RegValue (1 - 50, 0 = inactive)

The registers are displayed in blocks of 50. To display registers 701 to 750, we must set the 50 Register Block Read Address to 15.

To specify the block read address for a 50 register block:

1. Start **CTC Monitor**.
2. Select **DDE Setup** from the **Configuration** menu.
3. Select the Flag Register Configuration dialog box.
4. Select the 50 Register Block Read Address field by placing the mouse pointer on it and clicking the mouse.
5. Enter a number from 1 to 20 indicating the 50 register block you want. We entered 15.
6. Press **Return**.

The values in that block of registers appear in Register Data List.

<table>
<thead>
<tr>
<th>Register Write Address:</th>
<th>13002</th>
<th>Register Write Data:</th>
</tr>
</thead>
<tbody>
<tr>
<td>50 Reg Read Address:</td>
<td>1</td>
<td>Register Read Data:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reg#</th>
<th>Register Values:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0 0 0 0 0 0</td>
</tr>
<tr>
<td>6</td>
<td>0 0 0 0 0 0</td>
</tr>
<tr>
<td>11</td>
<td>0 0 0 0 0 0</td>
</tr>
<tr>
<td>16</td>
<td>0 0 0 0 0 0</td>
</tr>
<tr>
<td>21</td>
<td>0 0 0 0 0 0</td>
</tr>
<tr>
<td>26</td>
<td>0 0 0 0 0 0</td>
</tr>
<tr>
<td>31</td>
<td>0 0 0 0 0 0</td>
</tr>
<tr>
<td>36</td>
<td>0 0 0 0 0 0</td>
</tr>
<tr>
<td>41</td>
<td>0 0 0 0 0 0</td>
</tr>
<tr>
<td>46</td>
<td>0 0 0 0 0 0</td>
</tr>
</tbody>
</table>

7. If not open already, open the DDE channel from CTC Monitor. See *Opening a DDE Communications Channel* in this chapter.
**Setting up the DDE Application to Read the Flag Register Configuration Dialog Box**

Once you have specified the registers you want and opened the DDE communications channel from CTC Monitor, you need to open the DDE application and specify the application name, topic, and item you want to monitor. This example uses an Excel spreadsheet, but CTC Monitor can communicate with any software application that uses the DDE protocol.

1. Open the DDE application and create the report or list you want.

<table>
<thead>
<tr>
<th>Production Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monthly totals</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Daily totals</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

2. To start the DDE exchange, specify the application name, topic, and item for the register in the Monthly total field.

   =CTCMONIDdeSetup!'RegValue(1)’

(1) specifies the first register in the Register Data List on the Flag Register Configuration dialog box. Excel requires single quotes around RegValue(1) when specifying an item from an array. Make sure you have the correct format for your DDE application.

   Monthly total =CTCMONIDdeSetup!'RegValue(1)’

If you have the DDE server running from CTC Monitor when you are setting up your DDE application, the information from the controller appears in the appropriate field.

   Monthly total 4790

3. Specify the application name, topic, and item for the other registers.

**NOTE:** You can also specify the 50 Register Block Read Address from the DDE application. For more information and an example, see *Writing to CTC Monitor from a DDE Application* in this chapter.
**Reading Register Values Using a DDE Application**

**Setting Up the Block Write Configuration Dialog Box**

Alternatively, we could use the Block Write Configuration dialog box and specify only the registers we want to read. To do this, enter the register numbers in the Block Register Address list. You can specify up to 16 different registers. Once you have entered the register numbers, the Block Register Read Value list displays the values in the registers.

You can then create a link from a DDE application and read the values displayed in the Block Register Read Value list. The block register list is also an array. The DDE link for reading this information is:

```
Application: CTCMON
Topic: DdeSetup
Item: BlockRead (1 - 16, 0 = inactive)
```

To select specific registers to read:

1. Start **CTC Monitor**.
2. Select **DDE Setup** from the **Configuration** menu.
3. Select the Block Write Configuration dialog box.
4. Select the Block Register Address list by placing the mouse pointer in the **Reg#** field and clicking the mouse.
5. Enter the register number in the **Reg#** field.
6. Press **Return**.

As you enter each register number, the value in that register appears in the Block Register Read Value list.

7. Continue entering register numbers. The maximum number you can specify is 16.

<table>
<thead>
<tr>
<th>Reg#:</th>
<th>Write Value:</th>
<th>Read Value:</th>
</tr>
</thead>
<tbody>
<tr>
<td>701</td>
<td></td>
<td>4790</td>
</tr>
<tr>
<td>702</td>
<td></td>
<td>285</td>
</tr>
<tr>
<td>703</td>
<td></td>
<td>15</td>
</tr>
<tr>
<td>704</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>705</td>
<td></td>
<td>11</td>
</tr>
<tr>
<td>706</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>708</td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

8. Open the DDE channel from CTC Monitor. See *Opening a DDE Communications Channel* in this chapter.
Setting up the DDE Application to Read the Block Write Configuration Dialog Box

This example sets up the DDE exchange for a series of registers specified on the Block Write Configuration dialog box. Once you have specified the registers you want and have opened the DDE communications channel from CTC Monitor, you need to open the DDE application and specify the application name, topic, and item you want to monitor. This example uses an Excel spreadsheet, but you can use any software application that uses the DDE protocol.

1. Open the DDE application and create the report or list you want.

2. To start the DDE exchange, specify the application name, topic, and item for the register in the Monthly total field.

   =CTCMON|DdeSetup!'BlockRead(1)'

(1) specifies the first item in the block register address list on the Block Write Configuration dialog box. Excel requires single quotes around BlockRead(1) when specifying an item from an array. Make sure you have the correct format for your DDE application.

   | Monthly total | =CTCMON|DdeSetup!'BlockRead(1)' |

   Mon54

   If you have the DDE server running from CTC Monitor when you are setting up your DDE application, the information from the controller appears in the appropriate field.

3. Specify the application name, topic, and item for the next register.

NOTE: You can also specify the registers in the Block Register Address from the DDE application. For more information and an example, see Writing to CTC Monitor from a DDE Application in this chapter.
Reading a Flag’s State from a DDE Application

You can read the state of a flag using a DDE application. Before you can read flag states, you must open a DDE channel between CTC Monitor and the DDE application. See Opening a DDE Communications Channel in this chapter.

Flag states are read from the Flag Data List. This list is an array of 32 values, and the DDE link to it is:

Application: CTCMON
Topic: DdeSetup
Item: FlagValue (1 - 32, 0 = inactive)

To read a flag’s state set up the DDE application as follows:

1. Open the DDE application and create the report or list you want.

<table>
<thead>
<tr>
<th>Status of Flags 1 through 6</th>
<th>Flag State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flag 1 - Fill valve status</td>
<td></td>
</tr>
<tr>
<td>Flag 2 - Converyer belt status</td>
<td></td>
</tr>
</tbody>
</table>

2. To start the DDE exchange, specify the application name, topic, and item for the flag in the field.

=CTCMON\DdeSetup!’FlagValue(1)’

(1) specifies the first flag in the Flag Data List on the Flag Register Configuration dialog box. Excel requires single quotes around FlagValue(1) when specifying an item from an array. Make sure you have the correct format for your DDE application.

| Flag 1 - Fill valve status | =CTCMON\DdeSetup!’RegValue(1)’ |

If you have the DDE server running from CTC Monitor when you are setting up your DDE application, the information from the controller appears in the appropriate field.

3. Specify the application name, topic, and item for the other flags.
Writing Register Values Using a DDE Application

In addition to reading the values of registers, you may set up a DDE conversation with CTC Monitor to write values to registers. This is done by specifying the DDE information for a specific register and then sending the changes to CTC Monitor. You can set up the links to either the Flag Register Configuration dialog box or to the Block Write Configuration dialog box.

In both cases you must specify the following information:

- The register number
- The new value for the register
- Assign a Visual Basic macro to send the register number and value to CTC Monitor.

Once you have written the macro, you must design a method of executing the macro. One method of executing the macro is to create a button and assign the macro to it. For instructions on how to create a macro and execute it, see the documentation for your DDE application. For sample macros, see Appendix B, *Sample Visual Basic Macros for DDE Applications.*

Writing to the Flag Register Configuration Dialog Box from a DDE Application

When entering or changing register values using the Flag Register Configuration dialog box, you need to specify the following information:

- The register number by writing to the Single Register Write Address. The DDE information for this is:
  
  Application: CTCMON
  Topic: DdeSetup
  Item: RegAddress

- The new value by writing to the Single Register Write Data field. The DDE information for this is:
  
  Application: CTCMON
  Topic: DdeSetup
  Item: RegWrite

Before you can write new values to a register, you must open a DDE channel between CTC Monitor and the DDE application. See *Opening a DDE Communications Channel* in this chapter.

To change a register value by writing to the Flag Register Configuration dialog box:

1. Start the DDE application. This example uses Excel.
2. Enter the application name, topic, and item for the Single Register Write Address field.

| Number of widgets of each type to be produced | =CTCMON!DdeSetup!RegAddress |
| Register specifying number of type 1 widgets | |
3. Enter the application name, topic, and item for the Single Register Write Value field.

| Number of widgets of each type to be produced |
| Register specifying number of type 1 widgets |
| Number of type 1 widgets | =TCMONIDdeSetup!RegWrite | Mon56 |

The DDE application displays the current Single Register Write Address and the value in the register.

4. Create the Visual Basic Macros required to access the RegAddress and RegWrite fields on the Flag Register Configuration dialog box. Refer to the documentation for your DDE application for information on creating Visual Basic Macros and see Appendix B for sample macros.

5. To specify a register, enter the register number in the RegAddress field.

6. To write a new value to the register, enter it in the RegWrite field.

7. Execute the Visual Basic Macros to send the information to CTC Monitor.

Once CTC Monitor receives the information, it downloads the new value to the controller.
Changing a Flag’s State from a DDE Application

You can change the state of a flag using a DDE application. Flag states are displayed on the Flag Register Configuration dialog box and are changed by specifying the following information:

- The number of the flag you want to change in the Flag Write Address field. The DDE link to the information is:

  Application: CTCMON
  Topic: DdeSetup
  Item: FlagAddress

- The flag’s new state in Flag Write Data field. The DDE link to the information is:

  Application: CTCMON
  Topic: DdeSetup
  Item: FlagWrite

To download the new flag number you must write a Visual Basic macro. Once you have written the macro, you must design a method of executing the macro. In these examples, we create a button and assign the macro to it. For instructions on how to create a macro and execute it, see the documentation for your DDE application. For sample macros, see Appendix B, *Sample Visual Basic Macros for DDE Applications*.

Before you can change flag states, you must open a DDE channel between CTC Monitor and the DDE application. See *Opening a DDE Communications Channel* in this chapter.

To set up DDE to write to a specific flag:

1. Start the DDE application. This example uses Excel.
   
The Excel spreadsheet has two fields for each entry. The Flag number field specifies the number of the flag, and the New state specifies the new state of the flag.

2. Enter the application name, topic, and item for the Flag Write Address field.
   
   =CTCMON|DdeSetup!FlagAddress

<table>
<thead>
<tr>
<th>Change Flag Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flag number</td>
</tr>
<tr>
<td>New state</td>
</tr>
</tbody>
</table>

   Mon58

3. Enter the application name, topic, and item for the Flag Write Data field.

   =CTCMON|DdeSetup!FlagWrite

<table>
<thead>
<tr>
<th>Change Flag Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flag number</td>
</tr>
<tr>
<td>New state</td>
</tr>
</tbody>
</table>

   Mon59

   The DDE application displays the current flag number and state.
Changing A Flag’s State from a DDE Application

4. Create the Visual Basic Macros required to access the FlagAddress and FlagWrite fields on the Flag Register Configuration dialog box. Refer to the documentation for your DDE application for information on creating Visual Basic Macros and see Appendix B for sample macros.

5. To specify a flag number, enter it in the Flag number field.

6. To change the flag’s state, enter the new state in the New State field. Zero (0) indicates that a flag is clear, and one (1) indicates that it is set.

7. Execute the Visual Basic Macros to send the information to CTC Monitor.
   Once CTC Monitor receives the information, it downloads the information to the controller.
Installation Instructions
Installing CTC Monitor

For Windows 95, Windows 98 and Windows NT Users

To install the CTC Monitor software:

1. Place the Quickstep CD into your CD drive.

2. When the automatic installation program window appears, use the mouse pointer to select **Install CTC Monitor 2.7** and click the **Next** button.

3. Follow the instructions on the screen. When asked, enter the following information:
   - The directory to contain the CTC Monitor files (default is C:\Program Files\Ctcmon27)
   - The program group for the CTC Monitor icon (default is CTC Tools)

4. When the installation is complete, select **Finish**.

For Windows 3.11 Users

To install the CTC Monitor 2.4 software:

1. Place the Quickstep CD into your CD drive.

2. Open the **File** menu on the **Program Manager** and choose the **Run** command.

3. When the automatic installation program window appears, use the mouse pointer to select **Install CTC Monitor 2.4** and click the **Next** button.

4. Follow the instructions on the screen. When asked, enter the following information:
   - The directory to contain the CTC Monitor files (default is C:\QSWIN21\CTCMON)
   - The program group for the CTC Monitor files icon (default is Quickstep 2.1)

5. When the installation is complete, select **Finish**.
Sample Visual Basic Programs

Contents

Opening a DDE Channel 70
Reset Value in Register 71
Downloading Changes to the Controller 72
Resetting the Values in the Controller 75
Changing the State of an Output 76
Changing the State of a Flag 77
Opening a DDE Channel

Sub ctc_connect()
'open a channel to CTCMON
'The value in ctc_channel contains the channel number
ctc_channel = DDEInitiate("ctcmon", "ddesetup")
End Sub
Sub ctc()
' The module will set all specified CTC registers to the reset value defined
'in cell b2.
' get the users reset value from cell b2
Set resetvalue = Worksheets("Sheet1").Range("b2")
' select the CTCMON register to be loaded
DDEPoke ctc_channel, "BlockAddress(1)", Worksheets("Sheet1").Range("C5")
' load the CTCMON register
DDEPoke ctc_channel, "BlockWrite(1)", resetvalue
' do the same for the rest of the registers.
DDEPoke ctc_channel, "BlockAddress(2)", Worksheets("Sheet1").Range("C6")
DDEPoke ctc_channel, "BlockWrite(2)", resetvalue
DDEPoke ctc_channel, "BlockAddress(3)", Worksheets("Sheet1").Range("C7")
DDEPoke ctc_channel, "BlockWrite(3)", resetvalue
DDEPoke ctc_channel, "BlockAddress(4)", Worksheets("Sheet1").Range("C8")
DDEPoke ctc_channel, "BlockWrite(4)", resetvalue
DDEPoke ctc_channel, "BlockAddress(5)", Worksheets("Sheet1").Range("C9")
DDEPoke ctc_channel, "BlockWrite(5)", resetvalue

Sub download()
' This module will download new spreadsheet changes to the controller
' through CTCMON.
' Check block#1
If Worksheets("Sheet1").Range("e5") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e5")
    DDEPoke ctc_channel, "BlockAddress(1)", Worksheets("Sheet1").Range("C5")
    DDEPoke ctc_channel, "BlockWrite(1)", resetvalue
    Worksheets("Sheet1").Range("e5") = ""
End If
' Check block#2
If Worksheets("Sheet1").Range("e6") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e6")
    DDEPoke ctc_channel, "BlockAddress(2)", Worksheets("Sheet1").Range("C6")
    DDEPoke ctc_channel, "BlockWrite(2)", resetvalue
    Worksheets("Sheet1").Range("e6") = ""
End If
' Check block#3
If Worksheets("Sheet1").Range("e7") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e7")
    DDEPoke ctc_channel, "BlockAddress(3)", Worksheets("Sheet1").Range("C7")
    DDEPoke ctc_channel, "BlockWrite(3)", resetvalue
    Worksheets("Sheet1").Range("e7") = ""
End If
' Check block#4
If Worksheets("Sheet1").Range("e8") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e8")
    DDEPoke ctc_channel, "BlockAddress(4)", Worksheets("Sheet1").Range("C8")
    DDEPoke ctc_channel, "BlockWrite(4)", resetvalue
    Worksheets("Sheet1").Range("e8") = ""
End If
' Check block#5
If Worksheets("Sheet1").Range("e9") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e9")
    DDEPoke ctc_channel, "BlockAddress(5)", Worksheets("Sheet1").Range("C9")
    DDEPoke ctc_channel, "BlockWrite(5)", resetvalue
    Worksheets("Sheet1").Range("e9") = ""
End If
' Check block#6
If Worksheets("Sheet1").Range("e10") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e10")
    DDEPoke ctc_channel, "BlockAddress(6)", Worksheets("Sheet1").Range("C10")
    DDEPoke ctc_channel, "BlockWrite(6)", resetvalue
    Worksheets("Sheet1").Range("e10") = ""
End If
' Check block#7
If Worksheets("Sheet1").Range("e11") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e11")
    DDEPoke ctc_channel, "BlockAddress(7)", Worksheets("Sheet1").Range("C11")
    DDEPoke ctc_channel, "BlockWrite(7)", resetvalue
    Worksheets("Sheet1").Range("e11") = ""
End If
'Check block#8
If Worksheets("Sheet1").Range("e12") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e12")
    DDEPoke ctc_channel, "BlockAddress(8)", Worksheets("Sheet1").Range("C12")
    DDEPoke ctc_channel, "BlockWrite(8)", resetvalue
    Worksheets("Sheet1").Range("e12") = ""
End If

'Check block#9
If Worksheets("Sheet1").Range("e13") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e13")
    DDEPoke ctc_channel, "BlockAddress(9)", Worksheets("Sheet1").Range("C13")
    DDEPoke ctc_channel, "BlockWrite(9)", resetvalue
    Worksheets("Sheet1").Range("e13") = ""
End If

'Check block#10
If Worksheets("Sheet1").Range("e14") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e14")
    DDEPoke ctc_channel, "BlockAddress(10)", Worksheets("Sheet1").Range("C14")
    DDEPoke ctc_channel, "BlockWrite(10)", resetvalue
    Worksheets("Sheet1").Range("e14") = ""
End If

'Check block#11
If Worksheets("Sheet1").Range("e15") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e15")
    DDEPoke ctc_channel, "BlockAddress(11)", Worksheets("Sheet1").Range("C15")
    DDEPoke ctc_channel, "BlockWrite(11)", resetvalue
    Worksheets("Sheet1").Range("e15") = ""
End If

'Check block#12
If Worksheets("Sheet1").Range("e16") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e16")
    DDEPoke ctc_channel, "BlockAddress(12)", Worksheets("Sheet1").Range("C16")
    DDEPoke ctc_channel, "BlockWrite(12)", resetvalue
    Worksheets("Sheet1").Range("e16") = ""
End If

'Check block#13
If Worksheets("Sheet1").Range("e17") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e17")
    DDEPoke ctc_channel, "BlockAddress(13)", Worksheets("Sheet1").Range("C17")
    DDEPoke ctc_channel, "BlockWrite(13)", resetvalue
    Worksheets("Sheet1").Range("e17") = ""
End If

'Check block#14
If Worksheets("Sheet1").Range("e18") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e18")
    DDEPoke ctc_channel, "BlockAddress(14)", Worksheets("Sheet1").Range("C18")
    DDEPoke ctc_channel, "BlockWrite(14)", resetvalue
    Worksheets("Sheet1").Range("e18") = ""
End If

'Check block#15
If Worksheets("Sheet1").Range("e19") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e19")
    DDEPoke ctc_channel, "BlockAddress(15)", Worksheets("Sheet1").Range("C19")
    DDEPoke ctc_channel, "BlockWrite(15)", resetvalue
    Worksheets("Sheet1").Range("e19") = ""
End If
`Downloading Changes to the Controller`

'Check block#16
If Worksheets("Sheet1").Range("e20") <> "" Then
    Set resetvalue = Worksheets("Sheet1").Range("e20")
    DDEPoke ctc_channel, "BlockAddress(16)", Worksheets("Sheet1").Range("C20")
    DDEPoke ctc_channel, "BlockWrite(16)", resetvalue
    Worksheets("Sheet1").Range("e20") = ""
End If
'write a value to the writebox to trigger the download from CTCMON DDEPoke
ctc_channel, "WriteBox", resetvalue
End Sub
Sub ctc_update()
Set resetvalue = Worksheets("Sheet1").Range("b2")
DDEPoke ctc_channel, "BlockAddress(1)", Worksheets("Sheet1").Range("C5")
DDEPoke ctc_channel, "BlockAddress(2)", Worksheets("Sheet1").Range("C6")
DDEPoke ctc_channel, "BlockAddress(3)", Worksheets("Sheet1").Range("C7")
DDEPoke ctc_channel, "BlockAddress(4)", Worksheets("Sheet1").Range("C8")
DDEPoke ctc_channel, "BlockAddress(5)", Worksheets("Sheet1").Range("C9")
DDEPoke ctc_channel, "BlockAddress(6)", Worksheets("Sheet1").Range("C10")
DDEPoke ctc_channel, "BlockAddress(7)", Worksheets("Sheet1").Range("C11")
DDEPoke ctc_channel, "BlockAddress(8)", Worksheets("Sheet1").Range("C12")
DDEPoke ctc_channel, "BlockAddress(9)", Worksheets("Sheet1").Range("C13")
DDEPoke ctc_channel, "BlockAddress(10)", Worksheets("Sheet1").Range("C14")
DDEPoke ctc_channel, "BlockAddress(11)", Worksheets("Sheet1").Range("C15")
DDEPoke ctc_channel, "BlockAddress(12)", Worksheets("Sheet1").Range("C16")
DDEPoke ctc_channel, "BlockAddress(13)", Worksheets("Sheet1").Range("C17")
DDEPoke ctc_channel, "BlockAddress(14)", Worksheets("Sheet1").Range("C18")
DDEPoke ctc_channel, "BlockAddress(15)", Worksheets("Sheet1").Range("C19")
DDEPoke ctc_channel, "BlockAddress(16)", Worksheets("Sheet1").Range("C20")
DDEPoke ctc_channel, "WriteBox", resetvalue
' DDEPoke ctc_channel, "regwrite", ResetValue'
' DDEPoke ctc_channel, "Flagwrite", ResetValue
End Sub
Changing the State of an Output

Sub output_toggle()
' This module will toggle a controller output.
    Dim outval As Variant
    Set regnum = Worksheets("Sheet1").Range("A5")
' get the output number from cell "A5"
    DDEPoke ctc_channel, "regaddress", regnum ' load the register number to CTCMON
    outval = DDERequest(ctc_channel, "regread") ' read the current output state
    outvalue& = (1 - Val(outval(1))) ' invert the state of the output
    ' load the new state value cell "A1"
    DDEPoke ctc_channel, "regwrite", Worksheets("Sheet1").Range("A1") ' load the new
End Sub
Changing the State of a Flag

Sub Flag_Click()
' This module will write to the controller's flags based
' on the number and state defined by the user.
Dim flagval As Variant
Set regnum = Worksheets("Sheet1").Range("D32")
DDEPoke ctc_channel, "flagaddress", regnum
DDEPoke ctc_channel, "flagwrite", Worksheets("Sheet1").Range("D33")
End Sub

Sub flag_toggle()
Dim flagval As Variant
Set regnum = Worksheets("Sheet1").Range("A6")
DDEPoke ctc_channel, "regaddress", regnum
flagval = DDERequest(ctc_channel, "flagvalue(1)"
flag_value = (1 - Val(flagval(1)))
Worksheets("Sheet1").Range("A1") = flag_value
DDEPoke ctc_channel, "flagwrite", Worksheets("Sheet1").Range("A1")
End Sub
Index

A
Analog inputs
  monitoring 20
  viewing states of 21, 23
Analog outputs
  changing value of 25
  monitoring 24
  viewing value of 25

C
Changing
  analog output values 25
  flag states 17
  NVRAM Module register values 28
  register values 15
  turning digital outputs on or off 23
  values in data table 42
Communications
  between controller and PC 2
  configuration setup 8
  using Ethernet 9
  using RS-232 port 2
Configuration setup
  DDE
    Block Write Configuration window 54
    Flag Registration Configuration window 52
  using Ethernet 9
  using RS-232 port 8
Controller
  displaying configuration information 10
  fault messages
    reading 29
  monitoring program status 29
  resetting 12
  setting up communications 2
  starting 12
  stopping 12
CTC Monitor
  communications
    configuration setup dialog box 8
    data table utility overview 38
    file menu overview 32
    overview 6, 7
    using symbolic names 33
Custom dialog boxes
  creating 50
  opening 48, 49
  overview 46
    label display dialog box 47
    resource display dialog box 46
  saving 48

D
Data table
  changing font 40
  downloading to a controller 41
  editing entries in 42
  entering messages in 42
  entering values in 42
  monitoring 43
    specifying rows to monitor 43
  opening 41
  saving Data Tables 40
  uploading from a controller 41
  utility window overview 38
DDE
  canceling DDE read 55
  example
    changing register values 63
    changing the state of a flag 65
    reading register values 58
  exiting DDE conversation 55
  links to flags 53
  links to registers 53
  reading block of 50 registers 53, 55
  writing to 50 register block 55
  reading controller messages 55
  specifying update interval 55
  starting DDE read 55
Dialog box
  analog input 20
  analog output 24
  configuration setup 8
  controller configuration 10
  CTC Monitor file menu
    downloading a register file 36
    opening a register file 34
    opening a Symbol Table 33
    overview 32
    uploading a register file 35
  custom 46
    label display dialog box 47
    resource display dialog box 46
  data table 38
  digital input 18
  digital output 22
  flags 16
  NVRAM Module 27
  program status 29
  register 14
  servo motor 26
Dialog boxes and menus
  DDE Setup
    Block Write Configuration window 54
    Flag Registration Configuration window 52
Digital inputs
  monitoring 18
  viewing states of 19, 23
Digital outputs
  monitoring 22
  turning on and off 23
  viewing states of 23
Downloading
  data table to a controller 41
  register file to controller 36
E
Entering
  messages in data table 42
values in data table 42
Ethernet communications
  setting up
    for controller and PC 9
Examples
  changing register values 63
  changing the state of a flag 65
  reading flag states 62
  reading register values 57, 58
  setting up DDE exchange 57, 62
F
Fault messages
  reading 29
File
  register
    downloading to controller 36
    opening existing 34
    uploading from controller 35
Flags
  changing flag states 17
DDE address for
  changing state 53
  displaying state 53
  single flag 53
example
  reading flag states 62
  monitoring 16
  viewing flag states 17
I
Inputs
  monitoring
    analog 20
    digital 18
  viewing analog input states 21, 23
  viewing digital input states 19, 23
Introduction
  to CTC Monitor 6, 7
L
Launching CTC Monitor 4
  from the Quickstep editor 5
M
Menu
  CTC Monitor file menu
    downloading a register file 36
    opening a register file 34
    opening a Symbol Table 33
    overview 32
    uploading a register file 35
    data table 38
Menus and dialog boxes
  DDE Setup
    Block Write Configuration window 54
    Flag Registration Configuration window 52
Messages
  reading fault messages 29
Monitoring
  analog inputs 20
  analog outputs 24
  data table 43
    specifying rows to monitor 43
  digital inputs 18
  digital outputs 22
  flag states 16
  program status 29
  servo motor position and error 26
N
NVRAM Module
  changing values in registers 28
  entering values in registers 28
  monitoring 27
  viewing values in registers 28
O
Opening
  custom dialog box 48, 49
  data table 41
  register file 34
  symbol table 33
Outputs
  analog
    changing value of 25
    viewing value of 25
  digital
    turning on and off 23
    viewing states 23
    monitoring
      analog 24
      digital 22
Overview
  CTC Monitor 6
  window 7
  DDE setup 52
P
Program status
  monitoring 29
Q
Quickstep
  monitoring program status 29
R
Register file
  downloading to controller 36
  opening existing 34
  uploading from controller 35
Registers
  changing values in 15
  DDE address for
    reading block of 50 registers 53, 55
    reading value in single register 53
    single register 53
Index

writing data to single register 53
writing to 50 register block 55
entering values in 15
example
    reading register values 57
monitoring 14
viewing values in 15
Resetting
    the controller 12
RS-232 communications
    setting up
        for controller and PC 2, 8

S
Saving
    custom dialog box 48
    data table 40
Servo motor
    monitoring position and error 26
    viewing position and error values 26, 29
Setting up communications
    between controller and PC 2
        using Ethernet 9
        using RS-232 port 2, 8
Starting
    the controller 12
Starting CTC Monitor 4
    from the Quickstep editor 5
Stopping
    the controller 12
Symbolic names
    using with CTC Monitor 33

U
Uploading
    data table from a controller 41
    register file from a controller 35

V
Viewing program status 29
Viewing symbol names
    with CTC Monitor 33